HiPer SR
GNSS Receiver

- TOPCON



A2 TOPCON

HiPer SR
Operator’s Manual

Part Number 1003771-01
Rev A

©Copyright Topcon Positioning Systems, Inc.
February, 2014

All contents in this manual are copyrighted by Topcon Positioning Systems, Inc. All rights reserved.






Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the “Terms and Conditions”).

Please read the terms and conditions carefully.

Terms and Conditions

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local government protection agency for both private use and
commercial job sites.
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Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved.
Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access
to, any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such
information for the care and operation of the receiver. The information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and money, and are the result of original selection, coordination
and arrangement by TPS.
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Trademarks

HiPer SR™, TRU™, Magnet™, Pocket-3D™, and Topcon® are trademarks or registered trademarks of Topcon Positioning Systems,
Inc. Windows?® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned by
Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other product and
company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND
THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
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INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR
ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.
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License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) in connection
with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer the Software
or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the
license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the
Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the receiver. All ownership,
copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary
information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the receiver.
Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to
disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other
appropriate remedy.
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Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by
an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license, warranty
and limitation of liability).
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Safety

Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers. Users should review and heed the safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and
Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to
conflict of laws.

Specifications

The graphics in this manual do not depict the actual size of the components.

All specifications are subject to change without prior notice.
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Manual Conventions Y
0]
—rn
This manual uses the following conventions: %
Convention Description Example ()
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest, and click Enter.
Italic Reference to another manual or help document Refer to the Topcon Reference Manual.

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system performance, data
integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of warranty, or
personal injury.

QO G

Terms and Conditions P/N: 1003771-01 v



Table of Contents

Preface . ..oiii i i i i e ittt it i
Terms and Conditions. . . ... .ottt [

US ottt e e i
CoPYrigNES ot e e e e i
Trademarks .. ... e i
Disclaimer of Warranty . ......ot i i e e e i
License ABreemMENt .. .t e e e e iii
Confidentiality . ...t e iii
Website; Other Statements .. ... iv
Saf Oty .o e e e e iv
MiISCellan@ouUS . . ..o iv
SPECIICAtioONS . ..o e e iv
Manual ConNVENTIONS . ... ot e e e v

P/N: 1003771-01 vi



Introduction

............................................................. 1
HiPer SR Features . .. ..o e 2
Unpacking Your Receiver Kit . ..... ... i i e e e et e e e 3

System ComMPONENTS . ...t e e e 4
ACCSS OIS o\ttt ettt e e 5
Technical DOCUMENTS . . ..ottt e e e e e e e e e e e e e 5
Using Topcon Software With Your Receiver. . ... ...t e 6
Getting Technical SUPPOrt . .. .. i e e e e e 7
DSt . ot 8
Getting Acquainted . ..ottt ittt i it i it et e et 9
ReCeIVEr OVEIVIEW . .ot e e e e ettt s 9
HiPer SR (Basic Model) Housing OVerview . .......... ...t 10
HiPer SR (Cellular Model) Housing OVerview . ............oouiininiiniinannnn.n. 11
CablES. o e 12
AN BNNAS . .t e e 14
1Y/ =T 0. o PP 15
Internal Batteries . .. ..ottt e 15

P/N: 1003771-01

vii



LongLink Wireless Communication

................................................. 16
Integrated Cellular Modem (Optional) . ... e e 16
SIM Card SIots (OpLioN) ... oo it e e e e e 17
Ports Panel. . ... e 18
Display Panel Operations . ........ciiiiiiiiiiiiernnenronrsnrsnessnsansnnnas 19
Power BUtton ... e 20
Receiver Status LEDS. . ... oot 21
Tracking Status LED . ... .. it i i e e e e e e e 21
RECOrding LED ...ttt e ettt e e e 22
Communication LED ... ... e e 23
Bluetooth Only Status . ... ..ot i et e et et et et et e 23
Cellular Status . ... 24
Battery LED ..o e e e e e e 25
ManNaging POWer ... it ittt it iiiiiiiiee it teennanasesstosssnssssssossnnnnnnns 26
Turning On/Off the RECRIVEN . ...ttt e e et e e 26
Using Internal and External POWer SOUrCES . ... ..ottt it et e e i 26
Internal Batteries . ... oottt e 27

P/N: 1003771-01 viii



Charging the Batteries ...t i e e e e 29

INSUffiCIENt POWEN . . . oo e 29
Configuringthe Receiver ..........c.iiiiiiiiiiintiiieteneerenaerenaesannnns 31
Viewing Receiver Information . ... i e 31
Loading NeW FirmMWare. . . ..ottt e e et et et et e ettt ettt e e e e 33
AboUt the OAF. . . e 41
Checking the Receiver's OAF ... ... . i e e e et 41
Loading an OAF ... .. i e e e 42
Resetting the Receiver (Clearingthe NVRAM) . . . ... i et e 45
Field System Setup .......oiiiiiiiiiiiiiiiiiitteitnntonrsnssnssansansnnnns 47
Setting Up the Base ReCEIVEr. . ... ittt i e e e e e e et et et 48
Setting Up the ROVEr RECEIVET . . ..t it e e e e et e e et et e e 50
Measuring Antenna Height . ... ... . . e e 52
Collecting Data ........c.ciiiiiiiiiiitiiineienneennansonassenaesanassannnns 54
Setting Recording Parameters . ... ... i e 54
LOgEING RatES. . oottt e e e e e e 54
ReCOrding Data . .. .ot e e e e 54

P/N: 1003771-01



Managing Files. . ..ottt e e 55

Downloading and Deleting Files . . ...t e e e et 56
Troubleshooting ..........iiiiiiiiiiiiiiiiii i iiieettnaeeenansenansanannans 57
Check This Firstl ... o e e e e e e e e e 57
POWEriNgG Problems. . ..o e e 58
Receiver Problems . .. ... 59
Using the Reset BUttoNn ... ... i e e e et et et e et e 63
Bluetooth Problems . ... ... e 65
LongLink Problems . ... ... e e e 67
Cellular Problems . ... e 68
TRU Problems . ..o e e 68
Cleaning and Storing the Receiver. . ... . i i e e i 69
Getting CuStOMer SUPPOIT . . oot e e e e e e e e e e 69
Specifications ....... ... i i i it i et ettt 70
General Details .. ..o e e 70
Cellular Modem . . ..o 77

P/N: 1003771-01



Penta-Band Cellular Antenna

.................................................. 78
Broadband Cellular Antenna ....... ... i e 79
Product Identification . ........ ...t i i i i i 80
Safety Warnings .........oiiiiiiiiiiiiinrinenneenesontonsonssnssansnnsanns 81
General Warnings . ...t e e e 81
RECEIVEr WarniNgS . oottt i e et et e e e e e e e e e 82
USaBE Walrnings .. oottt et et e et et e e et e e e 82

=T = 0] Y o o 83
FCC ComPlianCe. . .ottt e e et et e e e 83
Industry Canada ComplianCe . . ..ottt e e e e e 84
Community of Europe ComplianCe . ...ttt e e e 85
European Community Declaration of Conformity with R&TTE Directive 1999/5/EC ..... 85
Declaration of Conformity (R&TTE Directive 1999/5/EC) . .. ... ii ittt 86
WEEE DireCtive . .ot e e e e e 89
Bluetooth Transmission Statements/Compliance .. ........ ... it i, 90
Korean KC-RF Compliance ... ..ottt e e e et ettt et e et e e 90
Korean KC-Cellular Modem Compliance. . ...t e e e e e e 91

P/N: 1003771-01

Xi



Japan Radio Law and Telecommunications Business Law Compliance .................... 91

Bluetooth Module Compliance ........... i e e e e e 91
Cellular Module Compliance . ...t i e e et 92
L€ o113 oY 93

P/N: 1003771-01 Xii



Introduction

Topcon’s HiPer SR receiver is a compact, lightweight, and completely integrated GNSS receiver for static and cable-free stop-and-
go/kinematic applications. The integrated receiver design includes a GNSS receiver board based on Vanguard™ technology,
industry leading Fence Antenna™, internal long-life batteries, memory storage, Topcon’s innovative LongLink™, and optional
cellular wireless communication technology. The HiPer SR delivers world-class positioning and navigation capability to your
application by tracking signals from multi-constellation satellite systems, including GPS, GLONASS, and SBAS.

Topcon offers two models of the HiPer SR receiver: Basic and Cellular. The Basic model includes Topcon’s exclusive LongLink
communication technology, which provides the perfect small job site system suitable for short range (up to 300m from the Base
station) RTK communication. The Cellular model includes LongLink technology and has a cellular modem integrated into the
receiver. You can use the cellular model to receive corrections from the NTRIP caster using an HSPA+ cellular model installed in the
receiver. You can also use the HiPer SR cellular model in a MAGNET Relay configuration for a cost-effective RTK solution over long
distances. The MAGNET Relay configuration enables you to operate up to 10 HiPer SR rovers with a single HiPer SR base.

The HiPer SR offers complete IP67 protection against dust and water ingress, in addition to superior vibration and shock resistance.
The Topcon communication interface allows you to quickly integrate Topcon’s premium GNSS performance within new systems
and quickly deliver world-class positioning and navigation support to your applications.
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Figure 1: HiPer SR Receiver

HiPer SR Features

The HiPer SR receiver’s advanced design eliminates the need for cables during operation, allowing for a simplified setup and less
parts to keep track of. The HiPer SR receiver features the following:

® Compact, lightweight, and rugged design
® Industry-leading Fence Antenna™ technology
® A premier multi-constellation Vanguard™ technology GNSS board

HiPer SR Features P/N: 1003771-01 2




® |Integrated multi-channel LongLink™ wireless communication technology

® Integrated cellular modem (optional) for cable-free network and MAGNET Relay operation without the need for an
external cellular modem-enabled data collector.

® Dual SIM operation (cellular model only) to easily switch between cellular providers1
® 2 GBinternal memory
* Internal batteries, providing at least 12 hours of operation for any configuration
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® A highly visible display panel with single-button operation

® USB and power/RS-232 ports
You can configure the HiPer SR receiver in a variety of ways, depending on your project requirements. Typically, the receiver
supports the following operation modes:

® Static/post-processing data collection

® Job site RTK using LongLink technology

* Network Rover for DGPS and RTK operation

®* MAGNET Relay operation

® SBAS-enabled operation

Unpacking Your Receiver Kit

This section describes the documentation, standard kit components, and accessories (depending on your purchase) that
accompany your receiver. When you unpack your receiver kit, verify you received the items listed in this section. Make sure the
items do not appear damaged from shipment. If any of the items are missing or damaged, contact your Topcon dealer or Topcon
technical support. See “Getting Technical Support” on page 7.

1. SIM slot 1 is the primary slot for the SIM card. You cannot operate dual SIM cards installed in the HiPer SR receiver at the same time. Contact
your local Topcon dealer for information about firmware support for operating Dual SIM cards in the receiver.
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® Standard components are illustrated in Figure 2.
® Receiver accessories are illustrated in Figure 3.
® Receiver documentation is listed on page 5.

System Components

The items illustrated in Figure 2 are included with your receiver.

<. B =

HiPer SR Reciever Power Cable Power Supply Power Charger Cable LISE Cable
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Quick Reference Card Warranty Card Penta-Band Cellular Antenna Carrying Case
{With Cafiular Mode!)

Figure 2: Standard System Components

~ You can download utility software for the HiPer SR receiver from the Topcon Total Care website at
= www.TopconTotalCare.com.

Unpacking Your Receiver Kit P/N: 1003771-01
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Accessories

Topcon offers a wide variety of accessories (see Figure 3) specially designed to improve system flexibility and job site efficiency.
For more details on the optional accessories available for HiPer SR, contact your Topcon dealer.

Precisi
Universal Tribrach Tﬁmr:r? 'S‘.'.?Epter Prism Spacer Measuring Taps

5
=+
=
o
ol
c
a
o)
3

Broadband (Half Wave)
Celiular Antenna

Range Pole

Figure 3: Receiver Accessories

Technical Documents

The HiPer SR Operator’s Manual and Reference Card are designed to help you set up and use your new receiver quickly and
efficiently. You can download a digital copy of the HiPer SR Operator’s Manual and Reference Card from the Topcon Total Care

website at www.TopconTotalCare.com

® HiPer SR Operator’s Manual — An on-screen help document that contains detailed information on how to use your new
receiver.

Technical Documents P/N: 1003771-01 5




® Topcon Receiver Utility (TRU) Reference Guide — An on-screen help document that contains detailed information on how
to use the TRU software. For more information about the TRU software, see “Using Topcon Software With Your
Receiver”.

,@ Depending on your location, a Quick Reference Card may be included with your standard kit.
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Using Topcon Software With Your Receiver

Use the HiPer SR receiver in conjunction with the Topcon Receiver Utility (TRU) and MAGNET Field™ or Pocket-3D applications
for a cable-free positioning solution. Topcon software enables you to configure the receiver and other external devices, manage
files, collect data, and perform survey and construction work flows.

The Topcon Receiver Utility (TRU) is a hardware configuration software for receivers and peripheral devices. You can install it on
desktop computers and data controllers. You can download the TRU software and manual from the Topcon TotalCare website
(www.TopconTotalCare.com). TRU Help is also available on the software.

Topcon’s MAGNET Field™ software for data controllers provides real-time communication, cloud storage, data collection and
exchange, and field solutions, such as topo, staking, roads, calculations, and more.

Pocket-3D is a program that runs on data controllers with Windows CE® and mobile platforms. Pocket-3D simplifies data
collection, allowing you to check cuts and fills, layout points and survey all or part of the job site quickly and efficiently.

Magnet Relay™ is a GNSS correction service hosted by the MAGNET Solution. With a subscription to MAGNET Relay, you can
connect the HiPer SR Cellular receiver to the Relay service (via a cellular connection) and use it as a Base for up to 10 Rovers.

Contact your Topcon dealer for more information about the Topcon software described above.

Using Topcon Software With Your Receiver P/N: 1003771-01 6




Getting Technical Support

Before contacting a Topcon customer representative about any problems with the receiver, see “Troubleshooting” on page 57
for some solutions that may fix the issue.

Contact your local Topcon dealer or visit the Topcon Total Care Web site (www.TopconTotalCare.com) for technical support.
///,@ For quick and effective support, provide a detailed description of the problem.

When contacting Topcon for technical assistance, provide the following information for better and faster service:

1. Adescription of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in TRU, select Save to
File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory and
storage capacity, etc.

Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Getting Technical Support P/N:1003771-01
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Website

The Topcon website provides current information about Topcon’s line of products. The support area of the website provides
access to Topcon field and office software, manuals, frequently asked questions, and so forth. To access the Topcon website,

visit www.topconpositioning.com.
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The Topcon’s TotalCare website also provides complete support, such as news, updates, reminders, training, live Webinars, and
customer service to help you get the information you need. Visit www.topcontotalcare.com.
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Getting Acquainted

The HiPer SR receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, batteries, memory storage, and
wireless communication devices.

Receiver Overview

The upper portion of the receiver contains GNSS and LongLink antennas enclosed by the radome, which is securely surrounded by
a shock-absorbing rubber bumper.

An easy-to-operate display panel, mounting socket, and labels with receiver information are located on the bottom of the
receiver’s magnesium alloy lower enclosure.

The HiPer SR receiver has a highly-visible display panel with single-button operation. The display panel enables you to view the
receiver’s operational status. For more information, see “Display Panel Operations” on page 19.

The mounting socket (Figure 4) connects the receiver to either a standard 5/8"-11 thread pole or adapter.

You can locate regulatory and product identification information on the two receiver labels. The product identification label
contains the serial number and part number along with a quick response (QR) matrix code. You can scan the QR code with any QR
code application on a smart phone and it will open the product information page at the Topcon Total Care website
(www.topcontotalcare.com).

Getting Acquainted P/N: 1003771-01 9
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Figure 4: HiPer SR Receiver (Basic Model): Bottom Enclosure Overview
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HiPer SR (Cellular Model) Housing Overview
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Figure 5: HiPer SR Receiver (Cellular Model): Bottom Enclosure Overview
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Cables

gently remove the cable.

0

M

=
The HiPer SR package includes a power supply cable, a USB cable, and a power adapter. Table 1 describes the cables included 5
with your receiver. 0Q
1

Align the keyways when connecting the power/serial cable to the receiver port. Turn the cable lock clockwise Na)

///,QS until it clicks to secure the cable in place. To disconnect the cable, turn the lock counter-clockwise, and then 5
-

~+

()

a

Table 1. Receiver Cables

Cable Description Cable lllustration

Receiver Power Cable

Connects the receiver to the power adapter through the
SAE connector.

p/n: 1000181-01

USB Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n 14-008081-01

Cables P/N:1003771-01 12




Cables

Table 1. Receiver Cables

Cable Description

Cable lllustration

Power Adapter

Charges the receiver when connected to a grounded
outlet and the power charger cable.

p/n 22-034101-01

Power Charger Cable
Connects the power adapter to a grounded outlet. Sever-

al options are available for the power charger cable based
on your country. If the kit does not include a power
charger cable, contact your Topcon dealer. Refer to the
these part numbers for available power charger cables:

p/n 14-008052-01 (USA connector)
p/n 14-008054-01 (EUR connector)
p/n 14-008074-01 (AUS connector)
p/n 1000475-01 (BRL connector)

Power and Serial Cable

Connects the receiver to the power adapter through the
SAE connector and an external device through the RS-232
port (DB9 connector). Typically, this cable is not shipped
with the standard kit configuration but is available to
purchase separately.

p/n: 1000182-01

P/N:1003771-01
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Antennas

Antennas

The HiPer SR package includes a quarter-wave penta-band cellular antenna. A broadband half-wave cellular antennais available

as a purchased accessory for extended cellular coverage in remote areas or areas where the supplied quarter-wave penta-band
cellular antenna is unable to deliver the expected performance.

Table 2. Antennas

Cable Description Cable lllustration

Penta-Band Cellular Antenna

Connects to the receiver’s ANT port. Offers a frequency

range of 850/900/1800/1900/2100 MHz (EU/US
GSM/WCDMA)

p/n: 1004061-01
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Table 2. Antennas

Cable Description Cable lllustration

Broadband (Half Wave) Cellular Antenna

Connects to the receiver’s ANT port. Offers support for
traditional cellular frequencies as well as the new LTE 700

MHz band and the UMTS bands (694-960/1710-2170
MHz)

p/n: 1001313-02

Memory

The HiPer SR is equipped with an internal, non-removable memory card that provides up to 2 GB of data storage. As data is
logged to the receiver’s memory, the REC LED displays the memory capacity status. See “Recording LED” on page 22 for more
information. To access the raw data files in the receiver’s internal memory, see “Managing Files” on page 55.

Internal Batteries

The HiPer SR receiver was designed with two internal, non-removable batteries, so there is no battery door or connectors to
worry about. These batteries, when fully charged, provide at least 12 hours of operation in any job configuration and are easily

charged using the supplied power adapter or an external power source. See “Internal Batteries” on page 27 for more
information.

Memory P/N: 1003771-01 15
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LongLink Wireless Communication

The Basic and Cellular models of the HiPer SR receiver have integrated LongLink™ wireless technology that enables multiple (up
to 3) cable-free connections to other HiPer SR devices for LongLink Base/Rover RTK systems. You can also connect the receiver
to other Class 1- and Class 2-enabled Bluetooth devices (such as data collectors and computers) using Bluetooth wireless
technology concurrently with LongLink connections.

Topcon’s LongLink technology enables communication of RTCM3 differential corrections between two HiPer SR receivers over
Bluetooth (up to 300 meters), eliminating the need for additional external radios for corrections. For more information, see
“Field System Setup” on page 47.

Integrated Cellular Modem (Optional)
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The HiPer SR receiver is now available in an optional cellular model that integrates Five Bands UMTS/HSPA+ (850/800, 900, 1900,
and 2100 MHz), Quad-Band GSM cellular modem in the receiver’s IP-67-rated housing. An integrated cellular modem extends
the HiPer SR receiver’s capabilities to connect to a network without pairing the receiver with an external cellular modem or cell-
enabled data controller.

LongLink Wireless Communication P/N: 1003771-01 16




SIM Card Slots (Option)

0
0]
=
The HiPer SR receiver, with an integrated cellular modem, is equipped with two micro-SIM card slots that allow you to switch 5
from one service provider to another as required. Using dual SIM cards enables you to use two cellular services without the need  [le)¢]
to swap the SIM card in the field. You can only install micro-SIM cards into these slots. >
0
c
~ ,gs SIM cart slot 1 is the primary slot. The integrated cellular modem installed in the receiver does not allow two Q
5 simultaneous network connections at the same time using two SIM cards. 2
()
a

SIM Card Slot 1 SIM Card Slot 2
(Primary) (Secondary)

Figure 6: Receiver Micro SIM Card Slots
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Ports Panel

The receiver is equipped with the following ports:

Ports Panel

USB — Used for high-speed data transfer and communication between the receiver and an external device.

Power/Serial — Used for communication between the receiver and an external device. Also used to power the receiver
when the internal batteries are not in use. See “Using Internal and External Power Sources” on page 26.

ANT — A TNC connector used to connect a cellular antenna to the receiver. The ANT connector is only available in the
HiPer SR cellular model.
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The TNC connector on the HiPer SR cellular model is an RF connector and not an external GPS/GNSS antenna
connector. The HiPer SR receiver integrates an internal GNSS antenna and does NOT SUPPORT connection to
external GPS antennas. Connecting an external GPS/GNSS antenna to the ANT port may damage the receiver
and will not be covered under the Warranty.

Cellular Models Only
Not a GPS Antenna Connector
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Figure 7: Receiver Ports Panel
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Display Panel Operations

The LED display panel (Figure 8) enables you to control receiver power and data recording. The LEDs display the status of the
satellite tracking, recording/memory capacity, Bluetooth and LongLink connections, and batteries. This chapter describes the
different LED blink patterns and what they mean.

Power Recording Battery
(PWR) (REC) (BATT)

@@@@@

Status Communication
(STAT) (COMM)

Figure 8: LED Display Panel

Display Panel Operations P/N: 1003771-01
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Power Button

The power button performs multiple functions. The duration in which the button is pressed and held determines how the
receiver will perform. While pressing the button, the LED panel indicates the selected operation using particular LEDs. Table 3
describes how to use the power button.

Table 3. Power Button Functions
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FUNCTION PRESS BUTTON LED DESCRIPTION

Power On 1+ seconds Power LED blinks green until the startup is complete, and then the LED
turns off.

Power Off 3-10 seconds All LEDs are off. Release the Power button when the Battery LED is solid
red.

Factory Reset 10-15 seconds All LEDs are off. Release the Power button when the Status LED is solid

Clear NVRAM red.

Erase All Files 15-20 seconds All LEDs are off. Release the Power button when the Recording LED is
solid red.
Note: This action is irreversible. If you are unsure about this action,
continue to hold down the button until all LEDs return to normal.

Disregard More than 20 seconds All LEDs return to normal, and the receiver has not taken any action.
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Table 3. Power Button Functions

FUNCTION

PRESS BUTTON

LED DESCRIPTION

Open/Close data file

3 times in a row within
2 seconds

The data file opens in static mode.

While the file is open, press the power button 2 times in a row within 1
second to switch back and forth between static and dynamic modes.

To close a data file, press the power button 3 times in a row within 2
seconds.

Refer to the Recording LED description.

Receiver Status LEDs

There are four status LEDs to provide you information about the battery life, tracked satellites, memory capacity, and Bluetooth
wireless connectivity. This section describes the color and behavior of each LED.

Tracking Status LED

The tracking status LED displays how many satellites the receiver is tracking.

Receiver Status LEDs

Table 3. Status LED Patterns

LED Color

Description

o> One blink per tracked GPS satellite.

P/N:1003771-01
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Table 3. Status LED Patterns

LED Color Description
2 S One blink per tracked GLONASS satellite.
3 P One blink when there are no tracked
satellites or solutions. It is Off otherwise.

Recording LED

The memory LED indicates if data is being written to memory and displays how much memory the receiver has available for
recording.

Table 4. Recording LED Patterns
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Function Description

Greater than 50% File logging is in progress. Each blink
indicates data is being written to
memory. When the receiver is in

Less than 10% dynamic mode, the LED blinks twice
every second. In static mode, the LED
blinks once every second.

Greater than 10%

Greater than 50% The file is closed. A solid light indicates

G han 10% no data is being recorded.
reater than 10%

000 000

Less than 10%
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Table 4. Recording LED Patterns

Display Function Description

) Alternating green and red LEDs indicate
Formatting memory | i files are being deleted.

Alternating red and yellow LEDs indicate

oS &

o & the memory card is being initialized or
formatted.
Missing or faulty The LED is off.
- memory

Communication LED
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The Communication LED displays the status of the cellular and Bluetooth activity. The following tables describe the
communication activity for three use cases.

Bluetooth Only Status

Table 5. Bluetooth LED Patterns

LED Color Description
Bluetooth is on. Waiting for a connection.
A single Bluetooth connection is established.
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Table 5. Bluetooth LED Patterns

LED Color Description

Multiple LongLink connections are established. The LED
- o> blinks for each connection every 5 seconds.

o Bluetooth is turned off.

Cellular Status

Table 6. Cellular LED Patterns

LED Color Description
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The cellular modem is starting up.

The cellular modem is transmitting or receiving data.

The cellular modem has started up, and the receiver is
L connected to a data collector through Bluetooth.

The cellular modem has detected data transmissions,
) L and the receiver is connected to a data collector through
Bluetooth.
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Battery LED

The Battery LED indicates the remaining charge of the internal batteries. When an external power source is utilized, the LED
turns green and begins to blink if the batteries begin to charge. See Table 7 for more information.

Table 7. Battery LED Patterns
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LED Color ‘ Description 8
THE RECEIVER IS ON; INTERNAL BATTERIES IN USE 6
<D The charge is greater than 50 percent. ©
()
The charge is greater than 15 percent. a
~+
=Y The charge is less than 15 percent. o]
-
THE RECEIVER IS ON; EXTERNAL POWER IN USE; PWR LED IS SOLID GREEN 0
< An external power source is in use, and the internal batteries are fully charged.
o> The internal batteries are at greater than 50% capacity; the batteries are being charged.
> The internal batteries are at greater than 15% capacity; the batteries are being charged.
L ) The internal batteries are at less than 15% capacity; the batteries are being charged.
THE RECEIVER IS OFF
< The receiver is connected to an external power source, and the batteries are fully charged.
L ) The receiver is connected to an external power source, and the batteries are being charged.
Receiver Status LEDs P/N: 1003771-01
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Managing Power

This chapter describes how to power the receiver, charge the internal batteries, and use an external power source.
Turning On/Off the Receiver

To turn on the receiver, press and hold the power button until the LEDs briefly flash. When the receiver is turned on, the receiver’s
channels initialize and begin tracking all visible satellites at any time and location.

To turn off the receiver, press and hold the power button for more than three and less than 10 seconds (release the power button
when the BATT LED blinks solid red). This delay prevents the receiver from being turned off by mistake.

The receiver will draw a small amount of power from the batteries when it is turned off. If the receiver is
@@ placed in storage for a long period, such as a few months, the batteries may become fully discharged. You will
need to use an external power supply or recharge the batteries before use.

Using Internal and External Power Sources

The receiver is powered by the internal batteries or an external power source connected to the power/serial port. If an external
power source is connected, the receiver draws power from it in preference to the battery.
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You can connect the receiver to an external power source, such as a vehicle battery, with 6.5 to 30 VDC to operate the receiver.
See “General Receiver Specifications” on page 77 for more information on external power source requirements to power the
receiver and charge the internal batteries.

Power input greater than 30 VDC could damage the receiver.
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Internal Batteries

The receiver first draws power from a connected external power source. When there is no valid external power source
connected or if the source has discharged lower than 6.5V, the receiver will draw its power from two high-capacity
internal batteries (non-removable). Depending on the use case, the hours of operation provided by the internal batteries
vary, as shown in Table 8.

~ The batteries are shipped from the factory with a partial charge. For maximum operating time, fully charge the
= batteries before using the receiver.
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Table 8. Operation Hours

Approx.
Use Description Hours of
Operation?
MAGNET Relay™ Base Base sending RTCM3 differential corrections to MAGNET 12
Relay Service via cellular connection.
MAGNET Relay Rover or Network Rover receiving RTCM3 differential corrections over 13
Rover (using the receiver’s integrated cellular connection.
cellular modem)
LongLink RTK Base Base sending RTCM3 differential corrections to one Rover. 15
LongLink RTK or Network RTK rover | Rover receiving RTCM3 differential corrections over 17
LongLink or from a Network site and connected through
Bluetooth to a data collector.
Static Survey Static setup logging raw GNSS data at 1 Hz. 20

a. When operated at 20° C.

Using Internal and External Power Sources
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Charging the Batteries

When the battery charge is low, the BAT LED changes from solid green to yellow and then red, depending on the remaining
charge (see “Battery LED” on page 25). When the receiver is connected to an external power source, the batteries begin to
charge whether the receiver is turned on or off.

To charge the batteries:

1. Connect the supplied power cable to the receiver’s power/communication port.
2. Connect the power cable SAE connector to the SAE connector of the power adapter.

3. Plug the power adapter into an available outlet for approximately five hours to fully charge the batteries. (You
cannot over charge the batteries; the batteries stop charging when they are full.)
The BAT LED blinks as the batteries charge.

1anmod 3uideuepy

~ Use a grounded wall outlet or grounded surge protector while charging. The socket should be located near the
= equipment and easily accessible.

Insufficient Power

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut down and
automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for the battery charge status. See
“Battery LED” on page 25 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become de-activated.
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To restore power to your receiver and turn it back on, do one or all of the following:

® Recharge the batteries.
* Make sure the power/serial cable is correctly connected to the receiver’s port.

a. Align the keyways when connecting the power/serial cable to the receiver port.

b. Turn the cable lock clockwise until it clicks to secure the cable in place.

c. Todisconnect the cable, turn the lock counter-clockwise, and then gently remove the cable.
® Connect the receiver to a different power source.
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~ Power supplied to the receiver should match the specifications provided by Topcon on the product. Failure to
= comply with these specifications may damage the receiver.
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Configuring the Receiver

The sections in this chapter describe receiver options, and how to load a new Option Authorization File (OAF), update firmware,
and perform a factory reset. To do this, you will need to download the Topcon Receiver Utility (TRU) software from the Topcon Total
Care website at www.TopconTotalCare.com. For information about installing the software, see the Topcon Receiver Utility (TRU)
Reference Manual, which you can also download from Topcon Total Care website.

Viewing Receiver Information

In the Topcon Receiver Utility (TRU), the Receiver Info window displays basic Receiver information, such as hardware and firmware
versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

Connect the receiver to a computer and open TRU.

In TRU, connect to the receiver.

Click Device » Application Mode » Receiver Managing.

Click Device » Connect.

In the Connection Parameters window, select the correct serial port, and click Connect.

own A wDNE

In the TRU main window, click the Information icon. The Receiver Info window (Figure 9) appears.
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Name Value o
@ Model HIPER_SR
I i O1THESYK252
8 Serial Number HiPer SR 1209-PP0O07
||| @ Board Version B110_5
8 GNSS Firmware Version 4.5 SPR Dec,30,2013 b I
1 GNSS Hardware Version 205
@k Vendor Topcon |
:‘ #8 CPU Freq., MHz 235
BERAM Size, KB 16,384

~ =Flash Memory Total, MB 3,839
=Flash Memory Available, MB 2,046
=AFlash Memory Free, MB 2,046

gcharging Level, % 1
Bpattery A, v 6.80 -

Refresh

Figure 9: TRU - Receiver Info
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains the following
two files:

® ramimage.ldr — the Receiver board RAM file
® main.ldp — the Receiver board Flash file

To upload firmware files to the receiver:

1. Connect the receiver to a computer using a USB, serial, or Bluetooth connection.

You can upload firmware to the receiver using a Bluetooth, USB or a serial connection. To connect the receiver
with a computer using a USB connection, you will need to install a USB driver. USB drivers and firmware are
available at www.TopconTotalCare.com.

2. Click Device » Application Mode » Firmware Loading.
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3. Click the Firmware Loading icon.
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= Firmware Loading ._ 4

Figure 10: TRU - Firmware Loading

Click Device » Connect.
5. Inthe Connection Parameters window (Figure 11), do the following:

a. Select the connection type. (The Network option is available for the HiPer SR receiver)
b. Select the port name.

c. Click Connect.

Loading New Firmware P/N: 1003771-01




Serial Port

Bluetooth

\ - 4

Figure 11: Connection Parameters Window

6. Inthe Select Device window, do the following:

a.
b.

C.

o

Loading New Firmware

Select Receiver in the Device Type field.

Set the Capture Method to Soft Break (recommended).
Click Next to select the firmware RAM Image file.

Click Next.
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Device Type

[ Receiver

NS

Modem Firmware Format

[GNSS (“dr. “ldp)

Receiver Port
Internal Modem
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Capture Method

[softBreak

0}
0
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l Serial Port Settings

[

Figure 12: TRU - Select Device

On the Select Files window, do the following:

Loading New Firmware

Click the Browse = next to Loader to search for and select the receiver board’s RAM file.

b. Click the Browse = next to Image to search for and select the receiver board’s main file.
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Loading New Firmware

F:b110_4_0Vramimage Idr

Image:

Fb110_4_0W\main Idp

Figure 13: TRU - Select Files Window

P/N:1003771-01

JuoD

NS

A 92y3 Su

¢)
0
=
<
¢)
=




8. When the Information window appears, the firmware version shows the firmware currently loaded on the receiver.
Click Next to upload the firmware.
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Name: Value

Device Type Receiver

Model HIPER_SR

Id OOM2VMES8VE
Board Version B110_4

GNSS Fimware Version 4.2 5PR Dec 27,2013
GNSS Hardware Version 205
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Figure 14: TRU — Firmware Information

9. Once the firmware loads and the confirmation window appears, click OK to return to the Connection Parameters
window.
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@ The firmware has successfully been updated.
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Figure 15: TRU - Firmware Confirmation

16. Click Device » Connect.
17. In the Connection Parameters window, select Serial Port and the port name, and then click Connect.
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18. In the TRU main window, click the Information icon and verify the firmware version you upload appears in the
Receiver Info window.
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MName Value

i Model HIPER_SR

i Id O0M2VMESSVE

¥ Serial Number HiPer SR 1064-PP 10004
¥ Board Version B110_4

¥ GNS5 Firmware Version 4.2 5PR. Dec, 27,2013
8 GNSS Hardware Version 205

¥ Vendor Topcon

¥ Receiver Board Temperature, °C 0.0
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#% CPU Freq., MHz 235
EHRAM Size, KB 16,384
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=IFlash Memory Total, KB
=IFlash Memory Available, KB
=IFlash Memory Free, KB

%[}harging Level, %
Flpattery A, v
%Power Supply, V
%Power Board, V

o

Figure 16: TRU - Receiver Info Window

Loading New Firmware P/N: 1003771-01




About the OAF

Topcon issues an Option Authorization File (OAF) to enable the specific options that you purchased. Topcon’s OAF system allows
you to customize and configure the receiver according to your particular needs, therefore purchasing only the options you
require.

The HiPer SR receiver typically ships with an OAF as per initial purchase of the receiver kit configuration. There are several
upgrade options available with the receiver that can extend the receiver’s functionality to better suit your job requirement.
Examples of upgrade options are listed below:

® GPS + GLONASS dual frequency static operation

® Longlink base and rover RTK operation

® Network RTK and MAGNET relay rover operation

® MAGNET relay base operation (Add-on OAF)
Contact your Topcon dealer or a representative for a complete listing of available options and pricing information.

Checking the Receiver’'s OAF

To use TRU to view the status of the receiver’s options:

1. Connect the receiver to a computer and open TRU. See the Topcon Receiver Utility (TRU) Reference Manual for
more information about connecting the receiver to a computer.
2. InTRU, connect to the receiver.

3. Click the Options E=l icon in the main window. The Receiver Options window (Figure 17) displays, so you can view

ptre

the current authorization options and upload new ones.
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Receiver Options

=E——

Option Name
GPS
Glonass
L1

L2
Cinderella

Position Update Rate, Hz
Raw Data Update Rate, Hz
Code Differential Base
Code Differential Rover
RTK Base

RTK Rover, Hz

Memory, MB

Co-op Tracking

1-PPS Timing Signal

Event Markers

In-Band Int. Rejection
Multipath Reduction

Refresh |

Current Purchased
Yes Yes

Yes Yes

Yes Yes

Yes Mo

Yes Yes

100 20

100 20

Yes Mo

Yes Mo

Yes Mo

100 Disabled
Mot supported 0

Yes Mo
Double Double
Double Mo

Mot supported Disabled
Yes

Leased
Yes
Yes
Yes
Yes
Yes
100
100
Yes
Yes
Yes
100
1,024
Yes
Double
Double
Enabled Outside USA

hi Yes
Upload OAF |

Exp. Date
9/24/2011
9/24/2011
9f24/2011
12f31/2011
9/24/2011
12/31/2011
12f31/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011

~

Save to File

Loading an OAF

Figure 17: Receiver Options

Topcon dealers provide customers with OAF files. For any OAF related questions, e-mail Topcon at options@topcon.com and

include the receiver’s ID and serial number. To obtain these numbers, see “Viewing Receiver Information” on page 31.

To load a new OAF:

1.
2.

About the OAF

Follow the steps in “Checking the Receiver’s OAF” on page 41.
Click Upload OAF on the bottom of the Receiver Options window (see Figure 17).

P/N: 1003771-01
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3. Navigate to the location of the new Option Authorization File (Figure 18).

Juo>

r |
[l Open
mvlj v Computer » 05 (C:) » HiPerSR ~ %3] [ Search Hiperse 2] (070)
Organize v New folder = 0 @ E
L. GNSS Internet Radio = Name ° D 5.
|/ GSR2T00 Config Tool
UMIVERSAL 6|
0 MAGNET INK =hd 09
| Mission Planning Tool E| ~+
L ModemTPS :
| NMEA Reader (D
|\ NTRIP Client po)
U pc-cou )
| Pocket3D A
| Quality Center m
| RegPro —
b RTKLib | — — 3 (<D
File name: _UMIVERSAL tpo - | Options Files (*tpo) - -
——
Cor=_D
——

Figure 18: Load OAF

4. Select the appropriate file, and click Open (Figure 18).
Topcon’s TRU initially checks to see if the selected file is compatible with the currently connected receiver. If you

chose afile not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver ID and
disables the Upload the File to the Receiver button.
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= Upload OAF E=EI ) & Upload QAF

‘ ('] C:\Receiver OAF\Universal. tpo

Property Value - Property Yalue C
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[Flreceivern _UntvERsAL_ [ [FRreceiverin 1037Gv630RK 5 .
[ElMode! KX-KXXKHX-XX Universal Legacy TEIVede 01100500 M T

EChedsum C19E = =Checksum B15F OQ
=Dealer Topcon Positioning Systems, Inc. EDaa\er Topcon Positioning Systems, Inc. -+
=Emawl T g g =Emai\ L —— o :
[Esubmitime 2012-05-20 21:01:19 [ElsubmitTime 2011-12-21 17:30:20 o)

EC\pher Digest
2 [Elcomments  MMI test files

. ; ol
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Figure 19: OAF Compatibility Check

5. Press Upload the File to the Receiver (Figure 19) to start loading the file.
If an OAF file is uploaded to the receiver, TRU will offer to reset the receiver to put new authorization options into
operation (Figure 20).

TR ==

@ The changes will take effect after reset. Reset the receiver?

Figure 20: Reset the Receiver

6. Click Yes.
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Resetting the Receiver (Clearing the NVRAM)

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as ephemeris data
and receiver position. The NVRAM also keeps the current receiver’s settings, elevation masks, recording interval, and
information about the receiver’s internal file system. Clearing the receiver’s NVRAM resets the receiver and restores the factory
default settings.

Although performing a “factory reset” of the receiver is not recommended as a common practice, there are times when it can
eliminate communication or tracking problems.

After performing a reset, the receiver requires time to collect new ephemerides and almanacs (around 15 minutes).

Resetting the receiver will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps information
about the receiver file system.

You can also use TRU to clear the NVRAM:

1. Connect the receiver to a computer, and open TRU. See the Topcon Receiver Utility (TRU) Reference Manual for
more information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.
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3. Click the Tools icon @ in the main window.

The Tools window appears, enabling you to reset the receiver and clear the NVRAM.
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Figure 21: Tools Dialog Box

4. Click Factory Reset, and then click Yes to continue.
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Field System Setup

The HiPer SR receiver’s advanced design eliminates the need
for cables during operation, allowing for a simplified setup
and less parts to keep track of.

@ S Receiver
— T Sraq

You can set up the HiPer SR receiver in static or RTK

configurations in the field. You can transmit RTK corrections Ralnge
from the Base to the Rover receiver using LongLink™ or Tribrach Pole
cellular wireless technology. At the same time, you can use Adapter

Bluetooth to connect to a controller running TRU, MAGNET
Field™, or Pocket-3D to configure the instrument, and to
collect and manage data.

Receiver

This chapter describes the field setup of your new receiver

for base or rover configuration.
Tripod

Figure 22: Equipment and Setup
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Setting Up the Base Receiver

Mount the receiver on a tripod with a tribrach, tribrach adapter, and prism spacer, as shown in Figure 23.

Position the base system (from step 1) over a known point.
Level the tripod and measure the height of the receiver from the ground using the tape measure. See “Measuring
Antenna Height” on page 52.

4. Press the power button to turn on the receiver. The integrated wireless device in the receiver turns on when the
receiver is powered.

5. Connect the receiver to the Bluetooth-enabled data collector, running Topcon Field software, to configure and start
the base HiPer SR receiver.

6. View the LED display panel for the receiver’s current status. See also “Display Panel Operations” on page 19.

I
o
a
")
<
0
-+
o
=
)
o
[
=
T

Setting Up the Base Receiver P/N: 1003771-01 48




Receiver

Prism Spacer

Tribrach
Adapter

I
o
a
")
<
0
-+
o
=
»
o
[
=
T

Tribrach

Tripod

Figure 23: Base Receiver
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Setting Up the Rover Receiver

Mount the receiver on the rover pole, as shown in Figure 24.
Attach a Topcon controller to the pole using a mounting bracket.
If you are not using a fixed height rover pole, measure the height of the receiver from the ground. See “Measuring
Antenna Height” on page 52.

4. Press the power button to turn on the receiver. The integrated wireless device in the receiver turns on when the
receiver is powered.

5. Connect the receiver to the Bluetooth-enabled data collector, running Topcon Field software, to configure the HiPer
SR as a rover receiver.

6. View the LED display panel for the receiver’s current status. See also “Display Panel Operations” on page 19.
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Figure 24: RTK Rover
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the station marker,
specify the following:

® Measured height of the antenna above the station marker

* Method of measuring the antenna height

* Model of the antenna/receiver used
Any necessary antenna phase center adjustments, based on the antenna model, is automatically applied. This adjustment, when
combined with accurately measured height and measurement methods, allows for correctly computed reference marker

coordinates.
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To accurately measure the antenna height:

1. Measure the antenna height above the control point or marker, either the slant height or the vertical height.
You may either measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of the
receiver at the base of the mounting threads, or measure the slant height to the Slant Height Measurement Mark
(SHMM) on the side of the receiver. For ARP and SHMM marks on the receiver, see Figure 25.

2. Record the antenna height, points name, and start time in the field notes.
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Figure 25: Antenna Height Measurement Points
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Collecting Data

This chapter provides general information about recording data, downloading it, and removing files to free up internal memory.
Setting Recording Parameters

The Topcon Receiver Utility (TRU) software enables you to set logging parameters, such as logging rate and types of messages, in
which to record data. See the TRU Reference Manual for more information. You can download this software and the TRU Reference
Manual from Topcon TotalCare (www.TopconTotalCare.com). TRU Help is also available on the software. The HiPer SR is compatible
with any Topcon field software for configuration and recording raw data.

Logging Rates

The receiver provides up to 2 GB of file space on the internal (non-removable) memory card. The amount of memory used to log
data depends on the logging rate. For more information about setting logging rate parameters, see the TRU Reference Manual or
the TRU Help, which is embedded in the software.

Recording Data

You can log raw GNSS data to the receiver’s internal memory and use the Topcon Receiver Utility (TRU) or MAGNET Office™
software to download the files to a computer.
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To start or stop recording data to the receiver, you can use the LED display panel or TRU.

Press the Power button to turn on the receiver.

Wait for the STAT LED to indicate satellites are being tracked. The STAT LED blinks green for GPS satellites and amber
for GLONASS satellites. A short red blink indicates the receiver has not solved a position. Five or more satellites
provide optimal positioning.

Press the POWER button three times within two seconds to begin recording. You can also select File

Explorer » Logs » Start in TRU to begin recording data.

Make sure the REC light is blinking green. This indicates that a file has opened and data collection has started. The
REC LED blinks each time data is saved to the internal memory.

When you have finished recording, press the POWER button three times within two seconds, and make sure the
REC LED is dark. You can also select File Explorer » Logs » Stop in TRU to end data recording.

To turn off the receiver, press and hold the POWER button for 3 to 10 seconds until all LEDs turn dark and the BAT
LED is solid red.

You can also log data using MAGNET Field software.

Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the receiver’s internal
memory, and automatically given a name and a *.tps file extension. You can then transfer a file of collected data to a computer
with file managing software, such as the Topcon Receiver Utility (TRU). This program allows you to use an automatic naming
feature, enter file names, and delete files as necessary. For more information, see the TRU Reference Manual, which you can
download from www.TopconTotalCare.com or see the TRU Help, which is available on the TRU software.

Managing Files

P/N: 1003771-01 55



Downloading and Deleting Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or backup. The
receiver’s internal memory holds a finite amount of files, so you will want to delete files to restore memory capacity.

When the internal memory is full, the receiver stops logging data, and the REC LED turns dark/off, indicating an error condition.
Existing data is not overwritten, unless you have the AFRM mode enabled.

There are two options for deleting raw data files from the receiver:
® Delete all of the files using the LED display panel (i.e. hold the power button for 15 to 20 seconds). This erases all of the
files in the receivers internal memory.

® Use a USB, serial, or Bluetooth connection to download the files to a computer. In TRU, you can select the files you want
to delete from the receiver. See the TRU Reference Manual for more information or TRU Help, which is available on the
software.
Once a connection is established, you can download all or some files to a computer or controller and then use the File Explorer
feature in Topcon Receiver Utility (TRU) to manage the raw data files. For more information about using TRU to download or
delete files, see the Topcon Receiver Utility (TRU) Reference Manual available at www.TopconTotalCare.com or TRU Help , which
is available on the software.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the hardware.

Check This First!

Before contacting your local dealer or Topcon Technical Support, check the following:

Check all external receiver connections carefully to ensure correct and secure connections. Double check for worn or
defective cables.

Check the receiver’s internal batteries for a full charge.

Check the power source for incorrectly connected cables, and ensure the power source is valid. See “Specifications” on
page 70 for external power requirements.

Check the software. Make sure the most current software version is downloaded onto the computer and the most current
firmware is loaded into the receiver. Check the Topcon website for the latest updates.

Check Topcon Technical Support (www.topconsupport.com) or Topcon Total Care (www.topcontotalcare.com) for the
latest updates.

Then, try the following:

Troubleshooting

Power cycle off/on the receiver by pressing the Power button or by using TRU (Tools » Reset receiver).
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® Restore default settings by pressing the Power button for 10 to 15 seconds or using TRU (Tools » Clear NVRAM). This
restores the receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This
action does not delete data files from the receiver memory.

® Erase all files by pressing the Power button for 15 to 20 seconds or by using File Explorer » Delete All Files in TRU. This
will delete all files stored in the receiver’s non-removable memory card.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
® The battery may be discharged.
— Charge the battery overnight. See “Charging the Batteries” on page 29.
* If you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.
* The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power up,
contact your local dealer or Topcon Technical Support for advice.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller

Cable specific problems:

® The cable is not properly plugged in.
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— Unplug the cable, then securely and properly reconnect it to the receiver.
® The cable is damaged.

— Use an undamaged cable. Contact a dealer to replace the cable.
® The USB driver is not installed.

— If you are using a USB cable connection, make sure the USB driver, included on the GPS+ Software CD, is
installed on the computer. You can also download the driver from the Topcon support Website at
www.topcontotalcare.com.

Generic problems:

* The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. Click Receiver Settings » Ports.

c. Change the Input Mode for the port used for connection to cmd.
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The receiver does not lock on to satellites for a long period of time

* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track satellites).

— Order a new OAF with the desired options activated to enable or extend validity of the corresponding receiver
options. Contact a dealer or visit the Topcon website for details.

— Refer to the “Receiver Managing” chapter of the Topcon Receiver Utility (TRU) Reference Manual for a detailed
description of options.

The receiver tracks too few satellites
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® The survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. InTRU, connect to the receiver.

c.  Onthe TRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A code
multipath reduction check box is selected.

® Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK solutions
® Incorrect Base coordinates entered.

— Specify the correct coordinates for the Base station using
TRU or another suitable field data collection software.

® There could be some obstruction to the LongLink connection.
— Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to the Rover.
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® The corresponding receiver options may be disabled or expired.

— Order a new OAF with the required options activated to enable or extend validity of the corresponding receiver
options.

The HiPer SR receiver requires different OAFs for LongLink, network and MAGNET relay rover, MAGNET relay
///,@ base, and external RTK base operations. Contact a Topcon dealer for details about available options to
purchase with the receiver.
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— Refer to the Topcon Receiver Utility (TRU) Reference Manual for a detailed description of options.

® There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track at least
five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on the TRU
main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
® Adiscrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:
a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).
b. InTRU, connect to the receiver.
On the TRU main window, choose Receiver Settings » Ports.

d. Double-click on the port to be configured and make sure the input mode of the Rover matches the format
of the Base output mode (i.e. RTCM3).

® Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).

Receiver Problems P/N: 1003771-01 61




— Ensure the elevation mask is less than 15 degrees.
* The elevation mask is above 15 degrees.
— Lower the elevation mask. To do this, on the TRU main window, choose Receiver Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
* There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).
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The receiver does not start logging data
® The receiver’s memory is disabled or expired.
— Make sure the memory option is enabled. For details, see the Topcon Receiver Utility (TRU) Reference Manual.
® The receiver’s internal memory card does not have free space.

— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files” on
page 56.
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Using the Reset Button

Press the Reset button only when you have tried all other options to recover the receiver’s operation using the
Topcon Receiver Utility (TRU) and the power button on the LED display panel. After pressing the reset button,
the receiver loses its modem profile, which is necessary to operate the cellular modem. After reset, the
modem profile must be reloaded to the receiver using TRU.

The Reset button is located under the SIM card slot cover. Pressing the Reset button causes a hard reset of the receiver and
should only be used if:
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® You have already used TRU to reset the receiver and there is no performance change. See “Resetting the Receiver
(Clearing the NVRAM)” on page 45.

® The receiver does not respond to commands.
® The receiver does not charge the internal batteries.
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To reset the receiver, gently push the reset button with the end of a paper clip until the receiver shuts off. Wait a few seconds
before using the power button to turn the receiver on again.
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Reset Button

Figure 26: Receiver Reset Button
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Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

TRU error message: Can’t find receiver

® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
® Thereis interference.
— Move the receiver, controller, or computer to an unobstructed location.
® The receiver is too far away.
— Move the devices closer together.
* The receiver is already connected via Bluetooth to another device.
— Disconnect the receiver from the other controller or computer.

///QS LonglLink connections will not interfere with Bluetooth connections to computers or controllers.

® The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).
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b. Click Configuration » Receiver » Ports. j

c. Change the Input Mode for the Bluetooth serial port used for connection to cmd. g

oA

. . . M

~ This is the most common cause for this error message. Use TRU to double check the settings for the n
= connection port. 8—
0

=

-]

(0)}

TRU error message: Open COM# port failed: Access is denied
® Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

® The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.
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Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it

® Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
® Bluetooth module settings may have changed.
a. If the settings are changed for the Bluetooth module, remove it from the list of discovered Bluetooth

devices using the Bluetooth manager program (supplied with the device used to manage the receiver).

b. Repeat the search.
LongLink Problems

The following are some of the most commonly encountered problems.

LongLink cannot discover the Base receiver

® The Base is out of range.
— Make sure the Base receiver is within 300 meters of the Rover.
® The Base is not responding.
— Make sure the Base is turned on.
® Make sure Bluetooth is turned on for the Base and Rover (i.e. the Bluetooth LEDs are blue on both receivers).
® Make sure there are no obstructions or interference.

A Bluetooth connection cannot be established

® A Longlink connection is not available at the Base. (i.e. 3 connections are already established.)
® Make sure there are no obstructions or interference.

LongLink Problems P/N: 1003771-01
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Cellular Problems

The receiver’s integrated cellular modem does not send and receive data

® Make sure the cellular antenna is properly connected to the receiver’s ANT port.

® Make sure you are within your cellular coverage with minimal obstructions. You may want to check the strength of the
cellular signals in your area using TRU. See the TRU Reference Manual at www.TopconTotalCare.com.

* ABroadband half-wave antenna (see “Antennas” on page 14) is also available as an accessory. If you are having cellular
reception problems using the supplied penta-band quarter-wave antenna, you may want to consider purchasing the
broadband half-wave antenna accessory. For more information, contact your local Topcon dealer.

TRU Problems
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The following is the most commonly encountered TRU problem.

TRU cannot connect to the receiver
® The receiver is turned off.
— Ensure the receiver has power and is turned on.
* |f using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
® |f using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.
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* |f using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.

— Make sure the computer and receiver use the correct ports for communication. For the HiPer SR receiver, this is
Bluetooth serial port A (btsp\a).

Cleaning and Storing the Receiver

® Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
* Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support

If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Topcon Customer
Representative. For contact information, see “Getting Technical Support” on page 7.
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Specifications

The HiPer SR is a Vanguard technology-based GNSS receiver featuring 226 channels and LongLink wireless technology for small job
site operations and cable-free network solutions. This chapter provides specifications for the receiver and its internal components.

General Details

Table 10 lists the receiver’s general specifications.

Table 9. General Receiver Specifications

Physical
Enclosure Magnesium alloy with Lexan radome
Color Topcon Yellow and Gray (bumper)
Dimensions (mm) 150 (w) x 150 (d) x 64 (h)
Weight (g) Up to 925g, depending on the configuration
Antenna Topcon Fence Antenna™ Technology
Integrated GGD antenna w/ internal ground plane
Status MINTER (4 LEDs + 1 power button)
display/panel
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Table 9. General Receiver Specifications wn

O

Serial/External Hirose H205-Series (6-pin, multiplex) 2

Power -
Q)

usB USB Mini B 2.0 (client) EJ'_

External antenna TNC for cellular antenna g

connector 0

Bluetooth antenna Fully integrated, high-sensitivity

Tracking

Number of 226 channels Vanguard™ ASIC with patented Universal

Channels Tracking Channel Technology®

Tracked Signals? GPS: L1 C/A, L1, L2P(Y), L2, L2C code and carrier

GLONASS: L1 C/A, L1P, L2 C/A, L2C code and carrier

SBAS WAAS/EGNOS/MSAS/QZSS) L1 code and carrier

Multipath Yes, code and carrier

reduction

PLL/DLL setting Adjustable bandwidth and order

Smoothing interval Pseudorange smoothing: Adjustable

Data Output

RTK Corrections TPS, RTCM SC104 v 2.x, 3.x; CMR/CMR+¢
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Table 9. General Receiver Specifications

ASCII Output NMEA 0183 version 2.x and 3.x
RTK position data 10 Hz

rate (max.)

Measurement data 10 Hz

rate (max.)

Data and Memory

Removable media None

Internal memory 2 GB

Message storage
rate (max.)

10 Hz; up to 3,000 files

Environment

Operating -20°C to +65°C (batteries)
temperature -40°C to +65°C (w/ external power)
Storage -40°C to +70°C

temperature

Humidity 100%, condensing

Waterproof rating

IPX7 (1 meter submersion)

Dust rating

IP6X (Fully dust proof)

General Details
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Table 9. General Receiver Specifications

Random vibration MIL-STD 202G, Method 214A, Test Curve A, 5.35g RMS

Sinusoidal vibration | SAE J1211:1978 Section 4.7, 4g Peak

Shock Mil STD 810-F Method 516.5. Table 516.5-I Alternate Test
Method of Classical Pulse; 40g, 11ms duration
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Topple 2.0m pole drop; 1.0m handling drop

Bump IEC 60068-2-27 edition 4, Table A.2
Peak acceleration 250 m/s2, 25G @ 6 ms duration

Technology

Topcon Vanguard™ ASIC technology

Fence Antenna™ Technology

Topcon advanced Multipath Rejection (AMR)
Quartz Locked Loop (QLL)

Topcon Automatic File Rotation Mode (AFRM)
Universal Tracking Channels

Power

Internal Batteries 7.4V, 5000 mAh

Battery charging <5 hours
time
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Table 9. General Receiver Specifications

Battery charging Connect the AC adaptor to charge the internal batteries.
method Available run charge when connected to an external
battery. Charging of internal batteries when power input
is greater than 12 V.
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Operating time 20 hrs (Static receiver logging raw GNSS data at 1 Hz)®
External power 6.5 to 30 VDC®

input

Power 2.0 W (RTK Rover with LongLink, using internal batteries
consumption at 20° C)

External power Input: 100-240 VAC, 50-60 Hz, 0.8A

supply adapter Output: +12VDC/2.5A

rating

Communication

Serial 1 port; Hirose H205-Series (6-pin, multiplex); RS232
RX/TX
usB 1 port; USB Mini B 2.0 (client)

LongLink™ wireless 3 simultaneous connections

Bluetooth v2.1 + EDR
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Table 9. General Receiver Specifications

Cellular

Yes. Via external Bluetooth-enabled controller or device,
or using the optional integrated cellular modem.

Survey Accuracy'

Static, fast-static
(post-processed)

L1 only:
H: 3 mm + 0.8 ppm (x baseline distance)
V:4 mm + 1 ppm (x baseline distance)
L1 +L2:
H: 3 mm + 0.5 ppm (x baseline distance)
V: 5 mm + 0.5 ppm (x baseline distance)

Kinematic, RTK

L1 +L2:
H: 10 mm + 1 ppm
V: 15 mm + 1 ppm

DGPS H:0.4m
V:0.6m
SBAS H:1.0m
V:15m
Cold start <40 sec.
Warm start <20 sec.
Reacquisition
<1 sec.

General Details
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Table 9. General Receiver Specifications

RTK Time-to-First- | <20 sec.®
Fix (TTFF)

QO

o

o

o

o

General Details

. Vanguard ASIC includes two dedicated channels for L-Band signal tracking. The
HiPer SR receiver does not support L-Band signal tracking.

. The HiPer SR includes the latest Vanguard ASIC technology, and is capable of

supporting planned signals for both Galileo and COMPASS. Support will be

incorporated to HiPer SR when these constellations have matured and are ready

for commercial use.

CMR/CMR+ is a third-party proprietary format. Use of this format is not

recommended and known compatibility issues can arise, affecting performance.

Use of industry standard RTCM 3.x is always recommended for optimal

performance.

Refer to “Operation Hours” on page 28 for approximate operating times of the
HiPer SR receiver in different configurations.

6.5 to 30 VDC is the operating range of the external power source when the

receiver is on. To turn the receiver on, the power input must be between 8 to 30

VDC. To charge the internal batteries, the external power input must be greater

than 12 VDC.

Accuracy will vary depending on the number of satellites used, obstructions,

satellite geometry (PDOP), occupation time, multipath effects, and atmospheric

conditions. Performance may be degraded in conditions with high lonospheric

activity, extreme multipath, or under dense foliage. For maximum system

accuracy, always follow best practices for GNSS data collections.

g. This may be affected by field (signal obstructions, multipath, satellite geometry)

and atmospheric conditions.

-
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Cellular Modem

This section describes the specifications of the HSPA+ cellular module offered with the HiPer SR receiver.

Table 10 lists the receiver’s modem specifications.

Table 10. General Receiver Specifications

General (3.5G Wireless Module Quad-Band GSM and UMTS/HSPA)2

Supported bands Five Bands UMTS/HSPA+ (WCDMA/FDD)
(850/800, 900, 1900, AND 2100 MHz)
Quad-Band GSM (850/900/1800/1900 MHz)

Data e HSDPA Cat. 10/HSUPA Cat.6 data rates
DL: max. 14.4 Mbps, UL: max. 5.76 Mbps

e EDGE class 12 data rates:
DL: max. 237 kbps, UL: max. 237 kbps

® GPRS class 12 data rates
DL: max. 85.6 kbps, UL: max. 85.6 kbps

e CSD data transmission 14.4 kbps, V.110

AT Command support | Control via standardized and extended AT commands
(Hayes, TS 27.007, TS 27.005)

Cellular Modem P/N: 1003771-01
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Table 10. General Receiver Specifications

Regulatory and
approvals

R&TTE, FCC, GCF, PTCRB, UL, IC, CE

a. For more information about the HiPer SR cellular model available for your market,
contact your local Topcon dealer.

Penta-Band Cellular Antenna

Table 11.

Penta-Band Cellular Antenna Specifications

Antenna size

W x H (10.4 x 49.0mm)

Frequency range

Penta-band EU/US GSM/WCDMA
(850/900/1800/1900/2100 MHz)

Connector type

SMA?

Material

Lead-free materials
ROHS compliant product

a. SMA to TNC adapter to connect the Penta-Band cellular antenna is included in

the standard kit.

Cellular Modem
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Broadband Cellular Antenna

Table 12. Broadband Cellular Antenna Specifications

Overall length is 7.75-in. (20 cm) in a straight position and
6.75-in. (172 mm) in a right angle position

694-960 and 1710-2170 MHz

Antenna size

Frequency range

suonedynads

Connector type | TNC male

Material Polyurethane with black matt finish and knurled connector
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Product Identification

Use the following chart to help you identify the type of modem in which your receiver is equipped. Serial numbers are located on

the label on the bottom of the receiver.

Receiver Serial Number Prefix Part Number
HiPer SR 1064 1000036-01
New HiPer SR Basic 1209 1002399-01
HiPer SR w/ Cellular Modem 1212 1002399-02
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Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 25cm between the user and the receiver when
operating LongLINK technology.

TPS receivers are designed for survey and survey related uses (that is, surveying coordinates, distances, angles and
depths, and recording such measurements). This product should never be used:
* Without the user thoroughly understanding this manual.

* After disabling safety systems or altering the product.
® With unauthorized accessories.

* Without proper safeguards at the survey site.

® Contrary to applicable laws, rules, and regulations.
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Receiver Warnings

Tampering with the receiver by the end users or non-factory authorized technicians will void the receiver’s

warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or otherwise
treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

Only allow authorized Topcon warranty service centers to service or repair this product.

Receiver Warnings P/N:1003771-01

M Alojes

Q
=
=
=)
0q
w0




The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the FCC radio
frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of RF energy that it deemed to
comply without maximum permissive exposure evaluation (MPE). But it is desirable that it should be installed and operated with
at least 20cm and more between the radiator and person’s body (excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part 15 of the FCC rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
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® Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the
following two conditions: (1) this device may not cause interference, and (2) this device must accept any
interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de
licence. L’exploitation est autorisée aux deux conditions suivantes : (1) [’appareil ne doit pas produire de
brouillage, et (2) l'utilisateur de I’appareil doit accepter tout brouilage radioélectrique subi, méme si le
brouillage est susceptible d’en compromettre le fonctionnement.

CAN ICES-3 (A)/NMB-3 (A)

Industry Canada Compliance P/N:1003771-01
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European Community.

European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

EN 301 489-1 V1.9.2 (2008-04)

EN 301 489-17 V2.1.1 (2009-05)

EN 300 328 VV1.7.1 (2006-10)

EN 60950-1:2006 (2nd edition) + A11:2009 + A1:2010 + A12:2011
EN 301 489-3 V1.4.1 (2002-08)

EN 300 440-2 V1.4.1

EN 301 489-7V1.3.1

EN 301 489-24 V1.5.1

EN 55022:2010

EN 55024:2010

The following CE mark is affixed to the device:

Community of Europe Compliance P/N: 1003771-01
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C€

This is a Class A product. In a domestic environment this product may cause radio interference in which case
the user may be required to take adequate measures.

Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky (Topcon) timto prohlasuje, Ze tento (HiPer SR) je ve shod se

[Czech] zakladnimi pozadavky a dalSimi pisluSnymi ustanovenimi smrnice
1999/5/ES.

Dansk Undertegnede (Topcon) erkleerer herved, at falgende udstyr

[Danish] (HiPer SR) overholder de vaesentlige krav og gvrige relevante krav

i direktiv 1999/5/EF.

Deutsch Hiermit erkléart (Topcon) dass sich das Geréat (HiPer SR) in

[German] Ubereinstimmung mit den grundlegenden Anforderungen und den
Ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.
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Eesti
[Estonian]

English

Espafiol
[Spanish]

[Greek]

Francais
[French]

Italiano
[ltalian]

Kaesolevaga kinnitab (Topcon) seadme (HiPer SR) vastavust
direktiivi 1999/5/EU pdhinduetele ja nimetatud direktiivist
tulenevatele teistele asjakohastele satetele.

Hereby, (Topcon) declares that this (HiPer SR) is in compliance
with the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Por medio de la presente (Topcon) declara que el (HiPer SR)
cumple con los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

ME THN NAPQYZA (Topcon Positioning Systemes,
Inc.) AHAQNEIOTI (GRX1) ZYMMOPOONETAI
MPOZ TIZ OYZIQAEIZ AMAITHZELZ KAI TIZ AOINEZ
ZXETIKEZ AIATA=ZEIZ THZ OAHITAZ 1599/5/EK.

Par la présente (Topcon) déclare que I'appareil (HiPer SR) est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Con la presente (Topcon) dichiara che questo (HiPer SR) &
conforme ai requisiti essenziali ed alle altre disposizioni pertinenti
stabilite dalla direttiva 1999/5/CE.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N:1003771-01
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Latviski
[Latvian]

Lietuvi
[Lithuanian]

Nederlands
[Dutch]

Malti
[Maltese]

Magyar
[Hungarian]

Polski
[Polish]

Portugués
[Portugues]

Slovensko
[Slovenian]

Slovensy
[Slovak]

Ar 30 (Topcon) deklar, ka (HiPer SR) atbilst Direktvas 1999/5/EK
btiskajm prasbm un citiem ar to saisttajiem noteikumiem.

Siuo (Topcon) deklaruoja, kad 3is (HiPer SR) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Hierbij verklaart (Topcon) dat het toestel (HiPer SR) in
overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Hawnhekk, (Topcon) , jiddikjara li dan (HiPer SR) jikkonforma
mal-tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm
fid-Dirrettiva 1999/5/EC.

Alulirott, (Topcon) nyilatkozom, hogy a (HiPer SR) megfelel a
vonatkozé alapvetd kdvetelményeknek és az 1999/5/EC iranyelv
egyéb eldirasainak.

Niniejszym, (Topcon) , deklaruj, e (HiPer SR) spenia wymagania
zasadnicze oraz stosowne postanowienia zawarte Dyrektywie
1999/5/EC.

(Topcon) declara que este (HiPer SR) esta conforme com os
requisitos essenciais e outras disposi¢des da Directiva 1999/5/CE.
(Topcon) izjavlja, da je ta (HiPer SR) v skladu z bistvenimi
zahtevami in ostalimi relevantnimi doloili direktive 1999/5/ES.
(Topcon) tymto vyhlasuje, Zze (HiPer SR) spa zakladné
poziadavky a vSetky prislusné ustanovenia Smernice 1999/5/ES.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N:1003771-01
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Suomi (Topcon) vakuuttaa taten ettd (HiPer SR) tyyppinen laite on
[Finnish] direktiivin 1999/5/EY oleellisten vaatimusten ja sita koskevien
direktiivin muiden ehtojen mukainen.

Svenska Harmed intygar (Topcon) att denna (HiPer SR) star |
[Swedish] Overensstammelse med de véasentliga egenskapskrav och évriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.

WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring this product is
disposed of correctly, to help prevent potential negative consequences for the environment and human health, which could
otherwise be caused by inappropriate waste handling of this product. For more detailed information about the take-back and
recycling of this product, please contact a supplier where you purchased the product or consult.

WEEE Directive P/N: 1003771-01 89



Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

® Baseband

* HCI

® Link Manager

® Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid for any antenna
with the same or less gain.

Korean KC-RF Compliance
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(Wireless specification): Bluetooth 2.1 + EDR
4= (Used Frequency): 2402-2480 MhZ

(the number of channels): 79

(Antenna Power): 2.1 dBi

(Type of the modulation): GFSK, 8PSK
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IsHE (Product Id Code): MSIP-RMM-T8S-HIPERSR; MSIP-CRM-T8S-WT-41N
WESDN; (Applicant): Topcon Positioning Systems, Inc.

JI1EE (Type of equipment): GPS surveying device with Bluetooth radio
[=R=TR01 = (Model Name): HiPeR SR or GSX2

Bluetooth Transmission Statements/Compliance P/N:1003771-01 20



HEoa (Year of manufacture): 2014
MZA L MZ=2IF (Manufacturer and country of origin): OnCore, USA
OIEI AY E5 (Applicant Code): T8S

—/

Korean KC-EMC Class A Statement
0l JPDl= g2 (A2) 88X &EHD
HELC XEA AIE3le HE 5822 L.

Korean KC-Cellular Modem Compliance

This optional integrated cellular modem (PHS8-K) reference application described on page 16 and page 72 (General Details -
Communication) complies with the requirements of the Korean Communications Commission (KCC). The certificate granted in

accordance with KCC has the identifier: KCC-CRM-QIP-PHS8K.

Japan Radio Law and Telecommunications Business Law Compliance

DIZ2A BOHA £= AHE XK= 0l B2 F=2I6HAID] Hieti

Bluetooth Module Compliance

The integrated Bluetooth module WT-41N reference application described on page 72 (General Details - Communication)
complies in accordance with the provisions of Article 38-24 paragraph 1 of Japan Radio Law. The certificate granted in

accordance with Japan Radio Law has the following:
Certification Number: ATCB013105

Identifier: R 209-J00047

Korean KC-Cellular Modem Compliance P/N:1003771-01 91



Cellular Module Compliance

The optional integrated cellular modem (PHS8-J) reference application described on page 16 and page 72 (General Details -
Communication) complies with the requirements of the Japanese Telecommunications Business Law and Ordinance Concerning
Conformity Certification of Specified Radio as well as with the requirements of the Japanese “Radio Law” and “Ordinance
Concerning Technical Conditions Compliance Approval and Certification Type for terminal Equipment.”

The certificate granted in accordance with the Telecommunications Business Law has the identifier: AD 12-0011 202.

The certificate granted in accordance with the “Radio Law” has the identifier: 202-SMA014.

Japan Radio Law and Telecommunications Business Law Compliance’/N: 1003771-01 92



Glossary

Glossary

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for nearby Rover (mobile)
GNSS receivers.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over short distances from
fixed and mobile devices.

C
COMPASS - BeiDou Navigation Satellite System maintained and operated by China.

G

GALILEO — The satellite system currently being maintained and operated by the European Union (EU) and European Space Agency
(ESA).

GGD — GPS + GLONASS Dual Frequency signal tracking.

GLONASS - The GLObal NAvigation Satellite System maintained and operated by the Russian Federation.
GNSS - Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS - The Global Positioning System maintained and operated by the United States Department of Defense.
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L
L1 —The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.
L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Aiesso|H

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s components and
control receiver operations.

LongLink™ - Topcon’s LongLink RTK technology provides short-range RTK communication up to 1,000 ft. (300m from the Base
station).

M
MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of the MAGNET
software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

N

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK corrections to the
Rover.

(0]

Option Authorization File (OAF) — This enables the specific features that a customer purchases.
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P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward, with the phase of
the signal being equal at any point on the sphere.

Pocket-3D - Field controller software by Topcon that supports both GNSS and TS.

R

Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the measurement quality
without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.

Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems. SBAS transmits differential
corrections and messages for navigation satellites that are within sight of a network or reference stations in a wide area, such
as a continent.

Static Survey — Typically uses a network or multiple baseline approach for positioning. This method provides the highest
accuracy and requires the longest observation times.

P/N:1003771-01 95
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T

Topcon Receiver Utility (TRU) — Hardware configuration software for receivers and peripheral devices. TRU is included on the
GPS+ Software CD that accompanied your receiver.

U

Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller, computer, etc.

P/N:1003771-01 96
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TOPCON

Topcon Positioning Systems, Inc.
7400 National Drive, Livermore, CA 94550
800-443:4567  www.topconpositioning.com
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